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Experiment HP-12: Rubber Hand Illusion

Lab written and contributed by: Dr. Jim Grigsby, Professor of Psychology & Professor of Medicine 

(Division of Health Care Policy and Research, Division of Geriatrics), and

Mr. Greg Fliney, Senior Research Specialist University of Colorado, Denver

Background

Multisensory integration is the study of how information from the different sensory modalities, such as 

sight, sound, touch, smell, self-motion and taste, may be integrated by the nervous system. A coherent 

representation of objects combining modalities enables us to have meaningful perceptual experiences 

of the world around us and be able to adapt our behavior as to what is being sensed.

The Rubber Hand Illusion is more than a prank to play on your friends. It is actually a window into the 

relationship between our mental and physical self-conception or bady awareness and ownership.  It 

combines the theory of multisensory integration and how that allows a person to exist in and react to 

their environemt.

During the illusion, a participant’s hand is hidden, and a rubber hand is positioned so that it appears as 

if it is her own. She knows that the hand is not real, but when both hands are stroked simultaneously, 

what is seen and felt by the subject becomes blurred. 

The rubber hand begins to feel like it belongs to the subject. Consciously the subject knows it’s not 

true, but that does not matter. The illusion can seem so real to people, that if the fake hand is 

threatened, then indivdiuals under the illusion’s spell respond as if it were their own hand being 

threatened. 

Scientists have shown, among other physical effects, that the hidden hand’s temperature actually drops 

during the illusion.  This shows that the illusion's effects aren’t simply mental, but have a physiological 

link as well.  "These findings show that the conscious sense of our physical self, and the physiological 

regulation of our physical self, are linked," writes a team of researchers led by Oxford University’s G. 

Lorimer Mosely and Charles Spence. "In fact, our results suggest that the conscious sense of our 

physical self may actually contribute to its homeostatic regulation." 

This may seem like a reworking of the mind-body link from things that are already known, that 

embarrassment can cause blushing; fear causes a burst of strength. But unlike these examples, the 

findings, published in the Proceedings of the National Academy of Sciences, connect the body and 

actual awareness of the body. 

Rubber Hand Illusion

In the rubber hand illusion (Botvinick & Cohen, 1999), human participants view a dummy hand being 

stroked with a paintbrush, while they feel a series of identical brushstrokes applied to their own hand, 

which is hidden from view. If this visual and tactile information is applied synchronously, and if the 

visual appearance and position of the dummy hand is similar to the subject's own hand, then people 

may feel that the touches on their own hand are coming from the dummy hand, and even that the 

dummy hand is, in some way, their own hand. This illusion is an early form of the body transfer 

illusion using vision, touch, and posture (proprioception).  
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In this lab exercise, you will perform the rubber hand illusion on different subjects using the iWorx data

recording equipment and determine any changes in various physiological parameters.

• A background questionnaire is initially given to participants, and it consists of various 

demographic questions and obtains information on a subject’s suggestibility, hobbies and 

activities, and imagination.

• The rubber hand illusion is conducted, and physiological measures of body schema changes are 

recorded.

• The subjects’ subjective experiences are further explained in a survey that immediately follows 

the illusion.

Other Multisensory Illusions

Ventriloquism

Ventriloquism has been used as the evidence for the Modality Appropriateness hypothesis. 

Ventriloquism describes the situation in which auditory location perception shifts toward a visual cue, 

such as the “dummy” speaking. The original study describing this phenomenon was conducted by 

Howard and Templeton, (1966) after which several studies have replicated and built upon the 

conclusions they reached. In conditions in which the visual cue is unambiguous, visual capture reliably 

occurs. 

Double-flash illusion

The double flash illusion was reported as the first illusion to show that visual stimuli can be 

qualitatively altered by audio stimuli. Participants are presented combinations of one to four flashes 

accompanied by zero to 4 beeps. They were then asked to say how many flashes they perceived. 

Participants perceived illusory flashes when there were more beeps than flashes. 

Experiment HP-12: Rubber Hand Illusion

Lab written and contributed by: Dr. Jim Grigsby, Professor of Psychology & Professor of Medicine 

(Division of Health Care Policy and Research, Division of Geriatrics), and

Mr. Greg Fliney, Senior Research Specialist University of Colorado, Denver

Equipment Required

PC or Mac Computer

IXTA data acquisition unit

USB cable

IXTA power supply

iWire-B3G GSR amplifier and electrodes
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iWire-B3G EMG electrodes

PT-104 Pulse plethysmograph

TM-220 Temperature sensor

Rubber Hand (right) – with a shirt sleeve attached that matches the dress shirt

Large button-down dress shirt

Corregated cardboard or wood box (60 cm x approx. 30 cm)

Two-way mirror

Black fabric

Meter stick

2 Small child's paintbrushes or make-up brushes

Surgical tape

Light source

Appendix for the Questionnaires for Subjects

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power 

socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to 

turn on the unit. Confirm that the power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv6Complete.iwxgrp. Select this group 

and click Open.

4. Pull down the Settings menu again. Select the RubberHandIllusion settings file in the Human 

Psychophysiology folder.

5. After a short time, LabScribe will appear on the computer screen as configured by the 

RubberHandIllusion settings.
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6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are programmed on the Preferences Dialog window which can be viewed by

selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

GSR and PT-104 Setup

1. Locate the PT-104 pulse plethysmograph and plug it into the Channel A5 input of the IXTA 

(Figure HP-8-S1).

2. Locate the TM-220 temperature sensor and plug it into channel A8 on the front of the IXTA.

3. Locate the iWire-B3G galvanic skin response amplifier and GSR electrodes (Figure HP-8-S2) 

in the iWorx kit.

4. Also connect the red, green and black electrodes to the iWire-B3G for recording EMG activity.

5. Plug the connector on the iWire-B3G GSR/EMG amplifier into the iWire 1 input of the IXTA 

(Figure HP-8-S3)

Note : Connect the iWire-B3G to the IXTA prior to turning it on.

6. Attach the GSR electrodes to the pointer and ring finger of the subject's hand.  Make sure the 

fingers are not too cold or too dry.

Figure HP-8-S1: PT-104 pulse plethysmograph and TM-220 temperature sensor.
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Figure HP-8-S2 The iWire-B3G galvanic skin response amplifier.

Note – the GSR unit is precalibrated.  No other calibration is needed.

Figure HP-8-S3: The equipment needed to record the information for the Rubber Hand Illusion lab: 

EMG, GSR, pulse and temperature.
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Calibration of Temperature Probe

Note: The TM-220 temperature probe is pre-calibrated and additional calibration is not necessary.  

The directions below are for your information if you would like to perform another calibration.

1. Place the tip of the temperature probe in cold water of a known temperature (~10oC). Type the 

Calibration <Cold Water Temperature> in the Mark box to the right of the Mark button on the 

LabScribe Main window.

2. Click on the Record button and press the Enter key on the keyboard. Record data until the 

voltage on temperature channel reaches a plateau; this usually takes about 20 seconds. While 

recording at this temperature, type the Calibration <Warm Water Temperature> in the Mark box.

3. Without stopping the recording, move the tip of the probe from cold to warm water of a known 

temperature (~40oC). 

4. Press the Enter key on the keyboard. Record the change in voltage on the Temperature channel 

until a plateau is reached (Figure HP-12-S4). Click on the Stop button to halt the recording.

5. Click File Save to save your data.

6. Use the Display Time icons on the toolbar to adjust the Display Time of the Main window to 

show the recording at both temperatures in the same window. 

7. Click the 2-Cursor icon so that two cursors appear on the Main window. Place a cursor on the 

plateau of the temperature recording taken from cold water and the other cursor on the plateau 

of the temperature recording from the warm water. 

Figure HP-12-S4: The output of the TM-220 temperature probe recorded at two different temperatures.

Data is used to calibrate the TM-220.

8. To convert the voltages at the positions of the cursors to temperatures, use the Simple Units 

Conversion dialogue window (Figure HP-12-S5). To access this dialogue window, click on the 
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arrow to the left of the channel title, Skin Temp, to open the channel menu. Select Units from 

the channel menu, and select Simple from the Units submenu. 

9. On the Simple Units Conversion window, make sure 2 point calibration is selected in the pull-

down menu in the upper-left corner of the window. Put a check mark in the box next to Apply 

units to all blocks. Notice that the voltages from the positions of the cursors are automatically 

entered into the value equations. Enter the two temperatures used in the calibration recording in 

the corresponding boxes on the right side of the conversion equations. Enter the name of the 

units, oC, in box below the pressures. Click the OK button to activate the units conversion.

Figure HP-12-S5: The Simple Units Conversion dialogue window with the voltages at the cursors set 

to equal the temperatures of the water used to calibrate the temperature probe.

Corregated Cardboard/Wood Box Description and Set Up (Figure HP-12-S6)

1. The box is composed of two compartments that are separated by a divider.

2. The compartments are open to both the subject and the researcher (who is sitting on the 

opposite side of the rubber hand illusion box). 

3. The compartments are also open at the top where there is a continuous two-way mirror that 

covers the top of the entire box. 

4. From the subject’s perspective, the left compartment contains the rubber hand and the subject’s 

right hand is placed in the right compartment. 

5. There is a black veil covering the openings that are facing the subject and researcher to 

minimize the light that enters the box. This ensures that the two-way mirror appears to be a 

purely reflective mirror. 

6. The black veil also covers the top of the right compartment (while still being underneath the 

two-way mirror) so that the subject can never see his/her hand throughout the illusion.

7. In the left compartment (where the rubber hand is located), there is a light source that, when 

turned on, illuminates the compartment so that the rubber hand becomes visible. In other words,

the mirror becomes translucent because there is light beneath it.

8. Each compartment has a mark where the actual and rubber hand’s right index fingers are placed.
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• The total distance between these markings is 30 cm 

• The distance from the right edge of the box (from the subject’s perspective) to the subject’s 

actual right index finger is 15 cm. 

• The length of the box is 60 cm x 30 cm with the divider placed in the center (30 cm from 

either side of the box).   

Figure HP-12-S6: Rubber Hand Illusion box set up.

Note: These exercises are best performed in groups of 3 individuals. Plan accordingly so that each 

group has enough members to perform the lab.

SEE APPENDIX FOR QUESTIONNAIRES FOR THIS EXPERIMENT.
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Experiment HP-12: Rubber Hand Illusion

Lab written and contributed by: Dr. Jim Grigsby, Professor of Psychology & Professor of Medicine 

(Division of Health Care Policy and Research, Division of Geriatrics), and

Mr. Greg Fliney, Senior Research Specialist University of Colorado, Denver

Illusion Box Set Up

Note: The box can be made of sturdy corrugated cardboard or wood.

1. Set up the box as stated in the Set Up document for this lab.

2. Mark the location in the right hand compartment where the subject is to place his or her right 

hand.

3. Place the rubber hand in the same location in the left hand compartment of the box.

Preparation of Subject

1. Have the subject answer both the Background and Lifestyle Questionnaire, and the Imagination 

Questionnaire.

2. Once the subject has answered the questionnaires, have them put on the shirt.

3. Place the GSR electrodes on the subject's pointer and ring fingers of their right hand.

4. Tape the temperature sensor to the back of the right hand.

5. Place the stickie EMG electrodes on the subject's right arm and snap the lead wires onto the 

electrodes, so that:

• the red “+1” lead is attached to the electrode near the elbow.

• the black “-1” lead is attached to the electrode in the middle of the forearm.

• the green “C” lead (the ground) is attached to the electrode on the wrist.

6. Place the PT-104, pulse sensor, on the subject's left thumb.  Make sure the sensor is secure but 

not too tight (Figure HP-12-L1).

7. Place the rubber hand in the left compartment of the box. Make sure the right index finger is 

placed at the pre-set marking. Ensure that only the cut sleeve attached to the rubber hand is 

visible and is coming out from the bottom of the veil.

8. Position the subject so that his/her body is midline to the rubber hand.

9. Place the subject's right hand into the right compartment so that his/her right index finger is 

aligned with the pre-set marking and is approximately the same depth in the compartment as the

rubber hand.

10. Before recording any physiological data, place a two-foot ruler over the box, and have the 

subject verbalize where it feels like his/her right index finger is located by reading the location 

off of the ruler in centimeters. Remove the ruler from the top of the box.
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Figure HP-12-L1: Placement of all the sensors for the Rubber Hand Illusion experiment.

Exercise 1: Recording Baseline Data and the Rubber Hand Illusion Data

Aim: To measure the subject’s physiological parameters for 1 minute of baseline data and 1minute of 

illusion data.

Procedure

1. Record a baseline recording of physiological function for 1 minute (do not disturb the subject or

perform any other tasks at this time).

2. Type Baseline Data <Subject’s Name> in the Mark box that is to the right of the Mark button. 

3. Click on the Record button. Press the Enter key on the keyboard to mark the recording.

4. Record for at least 1 full minute. Click Stop to halt the recording.

5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click 

on the Save button to save the data file. 

6. After 1 minute, turn the light on to illuminate the rubber hand compartment of the box and 

immediately begin the illusion. 

7. Ask the subject to focus on the rubber hand. NOTE: The subject’s actual hand will not be 

visible throughout the illusion. 

8. Make a notation in LabScribe that brushing has begun by typing Brushing in the Mark box and 

clicking the Enter key.
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9. Using two paintbrushes, brush the rubber hand and actual hand from the knuckles to the tips of 

the fingers for 1 minute. Be sure to brush each finger within this 1 minute interval.  Make sure 

to brush the same fingers on the subject's hand as on the rubber hand (Figure HP-12-L2).

10.  After this interval, turn off the light, make a mark in LabScribe that the “Brushing Ceased” by 

typing in the mark box and clicking the Enter key.

11. Place the ruler back on top of the box. When you place the ruler back on the box, be sure to 

place it so that the ruler is reversed (turned 180 degrees from the previous measurement). The 

numbers should be upside-down from the subject’s perspective. (Note: This ensures that the 

subject will not simply recall the last measurement.)

12.  Ask the subject to verbalize where it feels like his/her right index finger is located by reading 

the location off of the ruler in centimeters. 

13. Remove the ruler and continue recording the physiological functions for at least 1 minute. Do 

not disturb the subject or perform any other tasks at this time.

14.  Click on the Save button to save the data file. 

Figure HP-12-L2: The recording showing the period of 1 minute while the both subject's hand and the 

rubber hand are being brushed.
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15. Once the recording is complete, remove the subject’s hand from the box and remove all 

recording devices. 

Data Analysis – Baseline – Before Brushing

1. Click the down arrow to the right of the Mark button to display the marks made while 

recording.  Choose Baseline Data <Subject's Name>.  This will automatically bring the 

recording to the data recorded during baseline.

Figure HP-12-L3: Data recorded during brushing of the hand as displayed in the analysis window.  

Note that mean values for heart rate, skin conductance and temperature, as well as the absolute 

integral for EMG are all displayed in this window.

2. Use the Double Display Time icon to adjust the Display Time of the Main window to display 

the full one minute recording of the subject’s baseline data on the Main window. This section of

data can also be selected by:

• Placing the cursors on either side of the one minute recording of the subject’s data, and

• Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HP-12-L4) 

to expand or contract the one minute recording to the width of the Main window.

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window.
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4. Look at the Function Table that is above the Pulse channel. The mathematical functions:       T2-

T1, Mean and Abs. Int, should appear in this table. The values for time, mean heart rate, mean 

skin conductance and mean temperature, as well as the absolute integral of the EMG channels is

displayed in the table across the top margin of the each of the labeled channels.

5. Once the cursors are placed in the correct positions for determining these values in the one 

minute recording, the values can be recorded in the on-line notebook of LabScribe by typing the

name and value of the parameter directly into the Journal.

6. The functions in the channel menu of the Analysis window can also be used to enter the names 

and values of the parameters from the recording to the Journal. To use these functions:

• Place the cursors at the location stated above.

• Transfer the names of the parameters to the Journal using the Add Title to Journal 

function in the Tools menu.

• Transfer the values using the Add All Data to Journal function in the Tools menu.

7. Enter these values for the subject's Baseline in TableHP-8-L1.

Data Analysis – Brushing

1. Click the down arrow to the right of the Mark button to display the marks made while 

recording.  Choose Brushing.  This will automatically bring the recording to the data recorded 

while brushing both the subject's hand and the rubber hand (Figure HP-12-L3).

2. Repeat steps 2 through 6 from the baseline directions to analyze the data from the subject 

during the brushing of the hand.

3. Enter the data for the subject in Table HP-8-L1.

Data Analysis – Brushing Ceased

1. Click the down arrow to the right of the Mark button to display the marks made while 

recording.  Choose Brushing Ceased.  This will automatically bring the recording to the data 

recorded after brushing occurred.
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2. Repeat steps 2 through 6 as stated above to analyze the data from the subject after brushing has 

ceased.

3. Enter the data for the subject in Table HP-8-L1.

Table HP-8-L1: Mean Heart Rate, SCL, Temperature and Abs. Int from EMG Recorded Before, 

During and After Brushing for the Rubber Hand Illusion.

Subject’s Name

______________

Mean Heart Rate 

(bpm)

Mean SCL

(uSiemens)

Mean

Temperature (C)
Abs. Int. EMG 

Baseline

During Brushing

Brushing Ceased

Questions

1. Does the recording show a difference in mean heart rate in response to the brushing of hand or 

after brushing has ceased?

2. Does the recording show a difference in mean skin conduction in response to the brushing of 

hand or after brushing has ceased?

3. Does the recording show a difference in mean skin temperature in response to the brushing of 

hand or after brushing has ceased?

4. Is there any correlation between the changes in mean skin conduction, temperature and/or the 

heart rate during brushing or after?

5. Look at the EMG activity of the hand during baseline and while the hand was being brushed.  Is

there any change, an increase or decrease, in EMG activity?  What would cause this to happen?

6. Explain how the Rubber Hand Illusion works.
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Exercise 2: Optional Experiments

Aim: To determine the changes in the heart rate, skin conductance level, temperature and EMG activity

while performing other stimuli on the rubber hand only. 

Procedure

Note: All tasks will be performed on the rubber hand only after doing the above tests.  

The above tests MUST be performed in order to continue with the optional experiments listed below.

1. Brush only the rubber hand for 1 minute while recording data.  

• After the “Brushing Ceased” experiment, record 1 more minute of data while brushing 

the rubber hand only.

2. Attempt to “threaten” the Rubber Hand with a small knife (do not actually stab the hand) or 

lightly hit the rubber hand with your fist multiple times.

• After the “Brushing Ceased” experiment, record 1 more minute of data while 

“threatening” the rubber hand.

3. Place the rubber hand on ice.

• After the “Brushing Ceased” experiment, record 1 more minute of data while putting an 

ice pack on the rubber hand.

Data Analysis

Analyze the data for any of these optional experiments by following the Data Analysis directions for 

the Rubber Hand Illusion.
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